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最智能的Python的IDE：PyCharm
最新版本：	v1.0	

更新时间：	20200215	

简介

整理最智能的Python的IDE，PyCharm的各种好⽤功能，包括完整的Python项⽬开发的过程，从新建项⽬到项⽬调试，

直到最后的项⽬部署和发布。包括期间涉及的Python版本的设置，⽂件编码设置等常⻅问题。以及详细阐述其智能体现

在什么地⽅，包括了除了集成开发环境本身⽅便好⽤功能之外，还有项⽬配置、编辑Python⽂件期间的各种智能提示和

⾃动处理，和调试期间的智能识别和显示，以及对git⽀持很⼈性化，以及其他⼀些⽅⾯的⽀持，⽐如REST、
SciView、MongoDB、Markdown、ScientificMode等，最后总结⼀些常⽤的全局设置，和整理之前遇到的⼀些问题和经

验⼼得。

源码+浏览+下载

本书的各种源码、在线浏览地址、多种格式⽂件下载如下：

Gitbook源码

crifan/most_intelligent_python_ide_pycharm:	最智能的Python的IDE：PyCharm

如何使⽤此Gitbook源码去⽣成发布为电⼦书

详⻅：crifan/gitbook_template:	demo	how	to	use	crifan	gitbook	template	and	demo

在线浏览

最智能的Python的IDE：PyCharm	book.crifan.com
最智能的Python的IDE：PyCharm	crifan.github.io

离线下载阅读

最智能的Python的IDE：PyCharm	PDF
最智能的Python的IDE：PyCharm	ePub
最智能的Python的IDE：PyCharm	Mobi

版权说明

此电⼦书教程的全部内容，如⽆特别说明，均为本⼈原创和整理。其中部分内容参考⾃⽹络，均已备注了出处。如有发

现侵犯您版权，请通过邮箱联系我		admin	艾特	crifan.com	，我会尽快删除。谢谢合作。

鸣谢

感谢我的⽼婆陈雪的包容理解和悉⼼照料，才使得我	crifan	有更多精⼒去专注技术专研和整理归纳出这些电⼦书和技

术教程，特此鸣谢。

前⾔
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更多其他电⼦书

本⼈	crifan	还写了其他	100+	本电⼦书教程，感兴趣可移步⾄：

crifan/crifan_ebook_readme:	Crifan的电⼦书的使⽤说明

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2021-01-17
00:51:28

前⾔
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PyCharm简介

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-12
21:20:07

PyCharm简介
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选择PyCharm版本

PyCharm有2个版本，关于如何选择，现在整理如下：

官⽹截图：

概述

	Community	=社区版=免费版

轻量级，⽤于Python和科学计算的开发

Lightweight	IDE	for	Python	&	Scientific	development
说明：虽然号称功能少⼀点，但是对于多数⼈，尤其是普通开发⼈员，影响不⼤，⾜够⽤了

	Professional	=专业版=收费版

全部完整功能，⽤于Python和Web的开发

Full-featured	IDE	for	Python	&	Web	development
结论

建议：普通⼈选免费的社区版	Community	version	，⾜够⽤了。

社区版和专业版的PyCharm对⽐

对于两个版本的详细区别，整理如下表：

收费的：Professional	Edition专业版
免费的：Community	Edition

社区版

Web	development	with	JavaScript,	CoffeeScript,

版本选择

5

https://www.jetbrains.com/pycharm/download/


General
comparison

TypeScript,	HTML/CSS	and	more
Frameworks:	Django,	Flask,	Google	App	Engine,
Pyramid,	web2py
Remote	development	capabilities:	Remote
run/debug,	VM	support
Database	&	SQL	support	UML	&	SQLAlchemy
Diagrams
Scientific	Tools

点评：后续可能会⽤到的功能点：
Flask，Django
Remote	run/debug
SQLAlchemy	Diagrams

Intelligent	Editor
Graphical	Debugger
Refactorings
Code	Inspections
Version	Control
Integration

Python,
Frameworks	&
Tools

Cython
Django
AppEngine
Flask
Jinja2
Mako
web2py
Pyramid
Profiler
SQLAlchemy
IPython	Notebook
Diagrams
Remote	interpreters,	remote	debugging,	Vagrant,
Docker
Duplicate	code	detection
Code	coverage
.po	files	support
BDD	support
Profiler	integration
Thread	Concurrency	Visualization

Core	Python	language
support
Code	Inspections
Refactoring
Local	debugger
Test	runners
reStructuredText
support
PyQt
PyGTK
Package	management
Virtualenv/Buildout
Python	console

Platform

CSS/HAML/SASS/LESS/Stylus
Database/SQL
JavaScript	and	JS	Debugger
Perforce,	TFS
FTP/SFTP/FTPS	remote	host	deployment
TextMate	bundles
REST	Client
Puppet
File	watchers

XML,	HTML,	YAML,
JSON,	RelaxNG
Git,	Mercurial,	CVS,
Subversion,	GitHub
IntelliLang
Local	terminal
Task	management

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-15
14:05:33

版本选择
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Python项⽬开发

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-12
21:25:27

Python项⽬开发
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新建项⽬

下⾯以创建Python的Flask项⽬为例，来介绍如何⽤PyCharm新建项⽬：

	File	->	New	Project	

在	New	Project	弹框中左边，选择项⽬是	Flask	的类型

再去确认Python的解释器：

如果已经是你希望的Python，则⽆需操作；

如果不是，则可以添加对应的Python：点击	Existing	interpreter	的配置按钮，点击	All	Local	

此处可以看到有提示

	Note:	Flask	will	be	installed	on	the	selected	interpreter	

意思是：将会⾃动安装Flask到你所选择的虚拟环境中去。

-》	看来PyCharm针对于虚拟环境⽀持的很好了。

在弹框中选择对应的Python解释器版本：

新建项⽬
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确定后，即可看到	Existing	interpreter	是刚才所选的Python，以及同时设置好要项⽬要保存的路径：

点击	Create	即可创建出项⽬，且底部右下⻆会显示正在建⽴索引indexing：

新建项⽬
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可以看到此虚拟环境中相关的python3的库都可以正常检测到：

然后新建python代码：

新建项⽬
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输⼊⽂件名，点击OK：

即可创建出Python⽂件：

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-14
21:19:17

新建项⽬
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新建项⽬
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设置Python版本

新建Python项⽬后，记得要

选择	Python	版本

=设置Python环境

=设置Python解析器

=Python虚拟环境

（如果是虚拟环境的话）

尤其是

当系统中安装多个版本的Python
既有Python	2
⼜有Python	3

甚⾄有多个版本的Python	3
或本身有个Python虚拟环境

⽐如⽤	virtualenv	/	pipenv	等创建出来的Python虚拟环境

否则会出现：

⽆法正常调试

找不到已安装的库

下⾯详细介绍⼀下，新建Python项⽬后后，如何设置对应的：

PyCharm中设置当前项⽬的Python解析器

新建Python项⽬（或者打开⼀个已有Pyhton代码的项⽬）后，会提示你设置python解析器的：

点击后，等价于：

	PyCharm	->	Preferences	->	Project	xxx	->	Project	Interpreter	

设置Python版本
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此处，通过	pipenv	添加了虚拟环境后，再去此处设置对应的	python解析器	：

点击	Show	All	

设置Python版本
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列表中没有刚新建的虚拟环境中的python解析器，所以去	Add	local	：

然后发现PyCharm中已经⾃动帮我们检测到并选择好了：

	Existing	environment	中的interpreter，是我们新建的virtualenv中的python解析器：

点击列表，还可以看到其他检测出来的虚拟环境的解析器：

设置Python版本
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注：如果当前没有识别出你的Python版本，则需要⾃⼰⼿动输⼊路径去添加。

如果是	Virtualenv	创建的虚拟环境，⼀般对应的路径都在：

	/Users/YourUserName/.virtualenvs/YourProjectName-F4MCntjh/bin/python	

然后⾃⼰去选择：

确定后，返回添加⻚：

设置Python版本
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loading后，就可以找到当前python虚拟环境解析器中所安装的库了：

项⽬底部会显示，有后台任务去：

更新python解释器

重新建⽴索引indexing

设置Python版本
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然后就可以在项⽬左边的⽂件结构中的	External	Libraries	中看到当前Python解析器=当前Python版本，和已安装的相关

库了：

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-12
22:55:46

设置Python版本
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⽂件编码设置

要声明好⽂件编码，否则PyCharm会报错

详⻅：

【已解决】Mac中PyCharm中Python代码调试报错：SyntaxError	Non-ASCII	character	\xe7	in	file	on	line	but	no
encoding

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-15
22:57:17

⽂件编码设置
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调试项⽬

创建完毕项⽬，添加完毕代码后，即可去调试代码。

添加调试配置

调试代码前，需要先添加和调试的配置。

⾃动创建调试配置

对于多数情况下，其实可以⽤PyCharm的智能之处，⾃动⽣成调试配置，开始调试。

⽬前有2种⽅式：

1.	⽅式1：直接点击⼩爬⾍⼀样的	Debug	的按钮：

且⿏标移动上去，会提示	Debug	'xxx'	(^D)	

2.	⽅式2：点击	if	__name__	==	"__main__"	中的调试选项

对于代码中有：	if	__name__	==	"__main__"	的情况，PyCharm能⾃动识别出来，在左边会多出⼀个绿⾊按钮，

点击后，会出现多个选项：

调试项⽬
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点击其中的		Debug	'xxx'	

正常情况，即可⽣成调试配置，开始调试。

⼿动添加调试配置

点击	Run->Edit	Configurations	：

调试项⽬
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点击	+	创建⼀个Python的调试配置：

调试项⽬
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然后输⼊对应的配置参数：

	Name	：随便设置个名字即可，⽐如此处的：	testRestApi	

	Script	Path	:		/Users/crifan/dev/xxx/robotDemo/testRestApi.py	
你要调试的Python⽂件的完整路径

	Environment	variables	:		PYTHONUNBUFFERED=1	

调试项⽬
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	Working	directory	:		/Users/crifan/dev/xxx/robotDemo	
⼀般设置为当前项⽬的根⽬录

PyCharm⼀般也会⾃动设置为你	Script	Path	的值对应的⽂件所在的⽬录的

给Scrapy添加调试配置

对于⼀些相对特殊的项⽬，需要搞清楚配置要启动的python⽂件，和要传⼊的参数才可以。

⽐如，Scrapy项⽬，就是这种，对应调试配置如下：

核⼼参数：

	Script	Path	:		/your_python_version/site-packages/scrapy/cmdline.py	
	Parameters	:		crawl	yourScrapyProjectName	

即可正常启动调试：

遇到对应断点可以停下来：

调试项⽬
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调试代码

上述调试配置弄好后，加上断点：

点击每⾏代码的最左边，⾏号的左边，即可给该⾏代码加上断点

然后即可开始调试：

调试项⽬
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然后单步调试，进⼊下⼀⾏代码：

调试项⽬
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此处Flask的代码即可正常运⾏：

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-15
14:09:15

调试项⽬
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调试项⽬
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远程调试

⽬前没具体折腾过PyCharm的远程调试。

不过有找过⼀些资料：

使⽤PyCharm进⾏Python远程调试

Pycharm的远程代码编辑	-	kiwik's	blog

抽空去试试。

不过，根据版本选择的解释，看来是需要：收费的专业版PyCharm，才⽀持远程调试	remote	debug	。

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-15
14:08:51

远程调试
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调试⼼得

在PyCharm调试期间，有些⼼得和注意事项，整理如下。

如果切换调试⽂件，记得更新Debug配置

背景是，在某个项⽬中，分别要单独调试某⼏个Python⽂件。

当时已经调试完毕其中⼀个了：

然后切换到另外⼀个python⽂件去调试：

调试⼼得
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发现遇到很多奇怪的现象：

log输出也会别的⽂件的log
新⽂件中的断点也始终⽆法执⾏到

等等

最后发现原因是：调试的始终是之前的⽂件，即没有更改调试配置

所以需要去：更新Debug配置

调试⼼得
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去把之前的要调试的⽂件：

换成当前要调试的新的⽂件。

调试⼼得
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可以注意到：不仅要调试的⽂件名变了，对应当前⼯作路径，也更新了：

（PyCharm很是智能和⽅便，考虑的很周到）

然后才能继续调试：

调试⼼得
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举例：没有更新调试导致⽂件找不到FileNotFoundError

关于⽂件找不到：

【已解决】PyCharm中调试pipenv虚拟环境中⽂件出错：FileNotFoundError	Errno	2	No	such	file	or	directory	pipenv
run	python	py

后记：

此处的vocabulary.txt和py⽂件MongodbToMysql.py是在同⼀个⽂件夹	nlp/dialog/data/	下⾯的。

在移动了⼀次⽂件后：

都移动到了另外⽂件夹	processData/mysqlQa/MongodbToMysql.py	中了。

⽽之前的Debug调试设置中，是可以正常的执⾏代码：

vocabularyList	vocabularyList	==		setset((lineline..stripstrip(())		forfor	line		line	inin		openopen(("vocabulary.txt""vocabulary.txt"))))

去打开同⽂件夹下txt⽂件的。

但是在移动⽂件夹之后，再去调试，始终出错：

调试⼼得
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找了找原因，发现是：

在移动⽂件之后，之前的Debug配置中的当前⽬录，没有变化，所以去改为py所在的⽂件夹：

（通过单独选择py⽂件，⾃动会设置	Working	directory	，或者⼿动输⼊，都可以）

调试⼼得
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然后就可以解决找不到⽂件的问题了：

crifan.com，使⽤署名4.0国际(CC	BY	4.0)协议发布	all	right	reserved，powered	by	Gitbook最后更新：	2020-02-15
18:42:33

调试⼼得
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项⽬部署

开发和调试完毕项⽬后，会涉及到发布和部署项⽬代码。

PyCharm对于项⽬部署、代码上传也有很好的⽀持。

⽐如想要把本地调试好的项⽬代码：

	/Users/crifan/dev/dev_root/company/xxx/xxxRobotDemoServer	

上传到服务器对应位置：

	/yyy_20180101/web/server/robotDemo	

添加和配置Deployment参数

先去新增⼀个	Deployment	配置：

	Tools	->	Deployment	->	Configuration	

然后点击	+	加号去添加：

项⽬部署
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	Add	Server	中，输⼊名字后，选择类型是：	SFTP	

说明：此处由于服务器中没有配置FTP服务器，所以⽤只要⽀持	SSH	就内置⽀持的	SFTP	

项⽬部署
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对应的	PyCharm	的Deployment设置是：

	Connection	

详细配置：

	SFTP	Host	：	xx.xx.xx.109	

服务器的IP地址

	Port	：	22	

默认⼀般就是	22	

	Root	Path	：	/root	

选择之前，记得要先去设置好登录⽅式（⽤户名+密码，还是⽤户名+auth）
注意路径的设置：

可以点击三个点，去选择对应的路径

项⽬部署
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也可以点击	Auto	Detect	会⾃动

(默认)设置为当前⽤户的默认⽬录

此处⽤户是root，所以默认路径是：	/root	

	User	name	：	root	

SSH的⽤户名，⼀般都是	root	

	Auth	type	：	Key	Pair（OpenSSH	or	PuTTY）	

密码模式：之前⽤的多的是，⽤户名加密码

	Private	key	file	：	/Users/crifan/.ssh/id_rsa	

key⽂件模式：后⾯别⼈⽤了私钥⽂件，则选择	Key	Pair（OpenSSH	or	Putty）	

	Private	key	file	:选择之前⾃⼰创建好的，可以⽤于SSH登录的rsa的私钥⽂件

⽐如此处放在了：	/Users/crifan/.ssh/id_rsa	

如图

项⽬部署
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	Mapping	：

详细配置：

	Local	Path	：	/Users/crifan/dev/dev_root/company/xxx/xxxRobotDemoServer	

⾃⼰本地的⽬录，写绝对路径，好理解

	Deployment	Path	on	server	：	/yyy_20180101/web/server/robotDemo	

注意：此处的路径是相对于	Connection	中的	Root	Path	来说的

我此处的	Connection	中的	Root	Path	是	/root	

但是此处还是	/	开头的：	/naturling_20180101/web/server/robotDemo	

其实更简单省事的办法是：点击三个点，⾃⼰选择列出来的路径，即可

	Web	Path	on	server	：	/	

如图：

	Excluded	Path	

项⽬部署
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设置步骤

	Add	local	Path		-》然后输⼊对应的本地的要排除的路径

详细配置：

	/Users/crifan/dev/dev_root/xxx/xxxRobotDemoServer/tmp	

	/Users/crifan/dev/dev_root/xxx/xxxRobotDemoServer/logs	

	/Users/crifan/dev/dev_root/xxx/xxxRobotDemoServer/runtime	

如图：

如何使⽤=同步⽂件到服务器

之后就可以：

项⽬部署
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同步整个项⽬（有改动的部分)
先点击项⽬根⽬录后，再去点击	Tools	->	Deployment	->	Upload	to	xxx	

即可上传整个项⽬的所有⽂件（去除排除掉的）

同步单个⽂件

可以（在修改了某单个⽂件后）右击该单个⽂件，选择	Upload	to	xxx	，也可以直接单独上传该⽂件

项⽬部署
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上传后的提示
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智能之处
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作为IDE本身

PyCharm做为⼀个IDE本身，功能⽅⾯也做的很好了。下⾯举例说明。

⾃动识别⽂件类型并提示安装相关插件

和之前总结的VSCode中⼀样：

当打开不认识的类型的⽂件（应该是通过后缀名推测的）

然后就会提示安装对应插件，以便于更好的显示（⽐如代码⾼亮）：

根据提示去安装	csv	⽂件的插件	CSV	Plugin	：

作为IDE本身
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此处是第三⽅的插件（不是PyCharm官⽅的），所以会弹框提示	Third-party	Plugins	Privacy	Note	：

点击	Accept	即可。

插件安装完毕后会提示你重启：

点击	Restart	重启后，项⽬列表中⽂件有了新的图标，且⽂件内容可以代码⾼亮：

⽀持导致之前版本的配置

版本升级后，智能监测到之前版本，并导⼊之前的配置：

作为IDE本身
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项⽬配置

作为项⽬的配置⽅⾯，PyCharm也有很多智能之处。

显示当前安装的库的可升级的版本

Python的虚拟环境中所⽤的库，除了显示当前已安装版本外，甚⾄还会列出最新版本是多少，甚⾄检测出有哪些可升级

的库
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编辑期间

PyCharm的智能之处，在静态的代码⽂件编辑期间，也有很多的体现。

下⾯举例说明：

变量名重复

变量错误提示之	命名重复	

此处拷⻉上⾯⼀⾏后，修改了后⾯的值后，但是忘了及时修改前⾯的变量名了，然后变量名变⻩⾊警告提示出错了：

	Redeclared	xxx	defined	above	without	usage	

-》然后及时改为正常的变量名，即可：

-》很是贴⼼，防⽌笔误导致变量出错。

正则表达式语法错误则显示普通字符串颜⾊

折腾【已解决】Python的正则re的search查找不到值期间

都能检测出Python的	re	的	{m,n}	的格式，从⽽显示出正确的蓝⾊数字

⽽不⼩⼼写错成中间有多余空格：	{m,	n}	，都会显示出字符串的绿⾊

真的很智能->从颜⾊显示上就帮你容易识别出错误的正则的语法。

Python版本兼容性提示

编辑期间
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之前遇到提示：

点击	Yes	

变量提示： 	Shadows	name	from	outer	scope	

之前遇到代码

defdef		xxxxxx(())::
				forfor		((curIdxcurIdx,,	eachProductDict	eachProductDict))		inin		enumerateenumerate((curLoopProductListcurLoopProductList))::
						logging						logging..infoinfo(("[%s]	eachProductDict=%s""[%s]	eachProductDict=%s",,	curIdx	curIdx,,	eachProductDict	eachProductDict))
												((processedInfoDictprocessedInfoDict,,	toProcessInfoDict	toProcessInfoDict))		==	orderSingleMsStoreProduct	orderSingleMsStoreProduct((driverdriver,,	gCfg	gCfg,,	eachProductDict	eachProductDict))
						processedOrderTime							processedOrderTime	==	processedInfoDict	processedInfoDict[["orderNumber""orderNumber"]]

编辑期间
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												......

出现提示：

Shadows	name	from	outer	scopeShadows	name	from	outer	scope
This	inspection	detects	shadowing	names	defined	This	inspection	detects	shadowing	names	defined	inin	outer	scopes	outer	scopes

具体含义是：

函数内部的变量，如果和函数被调⽤的外部的变量⼀样的话，就被	PyCharm	中叫做	shadows	name	

这样的话，容易引发不容易觉察到的，由于函数内部和外部的变量名⼀致⽽引发的⼀些问题：

⽐如：内部函数名引⽤时不⼩⼼写错了时，就会导致其实调⽤了外部变量名，从⽽导致逻辑错乱。

所以解决办法是：

确保函数内部和外部的变量名不要重复，这样就不会导致可能由此导致的错误了。

后来代码做了改动：

在外部也有的⼀个全局变量	processedInfoDict	的情况下，把函数内部的	processedInfoDict	变量改名，⽐如改

为	hasProcessedInfoDict	：

processedInfoDict	processedInfoDict	==		{{"xxx""xxx"::		"yyy""yyy"}}

defdef		xxxxxx(())::
				forfor		((curIdxcurIdx,,	eachProductDict	eachProductDict))		inin		enumerateenumerate((curLoopProductListcurLoopProductList))::
						logging						logging..infoinfo(("[%s]	eachProductDict=%s""[%s]	eachProductDict=%s",,	curIdx	curIdx,,	eachProductDict	eachProductDict))
												((hasProcessedInfoDicthasProcessedInfoDict,,	needToProcessInfoDict	needToProcessInfoDict))		==	orderSingleMsStoreProduct	orderSingleMsStoreProduct((driverdriver,,	gCfg	gCfg,,	eachProductDict	eachProductDict))
						processedOrderTime							processedOrderTime	==	hasProcessedInfoDict	hasProcessedInfoDict[["orderNumber""orderNumber"]]
												......

就可以了消除警告了。
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调试期间

PyCharm的调试功能很强⼤，也很智能。

调试时实时打开项⽬外的⽂件

某次调试项⽬，遇到import导⼊了当前项⽬之外的⽂件：

继续下⼀步调试	Step	Into	的话，则可以打开，当前项⽬之前的⽂件去继续调试：

很是⽅便。

动态显示变量的属性的值

对于代码：

ifif		notnot	connection	connection..isConnectedisConnected::

	isConnected	是对象变量	connection	的属性值，PyCharm都⽀持显示：

当⿏标移动到	isConnected上	时，可以⾃动检测到	connection.isConnected	是个整体，然后动态显示出其值：

还是很好⽤的。
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git⽀持

PyCharm对于代码版本管理⼯具：	git	

⽀持的也很好。有很多细节功能值得⼀提，体现了智能之处：

⽂件名改动提示

git提交代码时，⽂件名改动都可以检测出来并提示你：

某次把	unit.py	改为了	units.py	，然后commit提交代码之前，就可以看到对应提示：

很是⼈性化。

检测出.gitignore排除的⽂件残留在git记录的项⽬中

当去编辑	.gitignore	，加上	.idea/	后，⽬的是，排除和项⽬代码⽆关的PyCharm的⼀些配置⽂件

此时，	PyCharm	会检测到此改动，并且提示你：

	.gitignore中发现排除了⼀些⽂件	

但是却（由于之前没排除，⽽加⼊）存在项⽬中

所以会问你如何操作

点击查看详情

此时，会⾃动列出代码：

#	in	directory:	/Users/crifan/dev/dev_root/xxx/StorybookQueryServer#	in	directory:	/Users/crifan/dev/dev_root/xxx/StorybookQueryServer
gitgit		rmrm	--cached	--force		--cached	--force	".idea/inspectionProfiles/Project_Default.xml"".idea/inspectionProfiles/Project_Default.xml"
gitgit		rmrm	--cached	--force		--cached	--force	".idea/dictionaries/crifan.xml"".idea/dictionaries/crifan.xml"
gitgit		rmrm	--cached	--force		--cached	--force	".idea/markdown-exported-files.xml"".idea/markdown-exported-files.xml"

你点击OK后，即可从git本地缓存中删除这些之前误操作保存到git中的⽂件

git⽀持
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然后再去commit提交时：

即可发现，已经去除掉了刚才还存在的	.idea	⽂件夹中的那些⽂件

-》由此⾃动帮你检测出问题，还给出问题的解决⽅案的IDE，才叫真的智能。

对于 	.gitignore	的智能⽀持

安装了	.ignore	插件后，⾃动检测出并提示：

	Would	you	like	to	add	unversioned	files	to	the	.gitignore	file?	

意思是：虽然有些⽂件之前被放到了.gitignore中，但是却也被加⼊到了git中了：

git⽀持
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点击	Add	unversioned	files	，弹框	Untrack	Ignored	Files	：

#	in	directory:	/Users/crifan/dev/dev_root/xxx#	in	directory:	/Users/crifan/dev/dev_root/xxx
git	rm	--cached	--force	git	rm	--cached	--force	".idea/misc.xml"".idea/misc.xml"
git	rm	--cached	--force	git	rm	--cached	--force	".idea/naturling.iml"".idea/naturling.iml"

git⽀持
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git	rm	--cached	--force	git	rm	--cached	--force	".idea/modules.xml"".idea/modules.xml"
git	rm	--cached	--force	git	rm	--cached	--force	".idea/workspace.xml"".idea/workspace.xml"

意思是：之前已经把PyCharm的项⽬配置	.idea	⽬录加到git管理中了，但是此处	.gitignore	中却⼜排除管理了：

#	pycharm#	pycharm
.idea/.idea/

所以有点⾃相⽭盾了。

⽽此处的处理是：	继续把	.idea/	加⼊到项⽬管理中。

⽽把	.gitignore	中改为：

#	pycharm#	pycharm
#.idea/#.idea/

即可。
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其他⽀持
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REST
PyCharm⾃带	REST	Client	，可⽤于测试RESTful	API：

测试效果：

REST
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SciView
⽆意间发现PyCharm中（在Mongo窗⼝的下⾯）有个：	SciView	

查了下，得知是⽤来显示	科学计算Python	Scientific	相关的图表的

即：	SciView	是	PyCharm	⽀持的科学计算	Python	Scientific	模式中的功能之⼀，⽤来显示科学计算相关数据的图表的：

SciView
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MongoDB
PyCharm中有插件	mongo4idea	，可以⽀持⽅便的操作	MongoDB	。

详⻅：

【已解决】⽤PyCharm写Python的MongoDB代码并调试

【已解决】PyCharm中安装MongoDB的插件：mongo4idea
【已解决】⽤PyCharm的MongoDB插件连接远程MongoDB数据库

【已解决】PyCharm连接远程添加security的authorization的MongoDB出错：

com.mongodb.MongoCommandExceptions:	Command	failed	with	error	13
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Scientific	Mode
PyCharm还针对，科学计算⽅⾯，提供了⼀个	Scientific	Mode	

之前遇到过，⾃动检测到代码⽤到了科学计算中最常⽤的库之⼀：	Numpy	

就提示是否要切换到	科学计算模式	：

不过此处暂时不切换。
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全局设置
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常⽤快捷键

此处整理	PyCharm	中常⽤的⼀些快捷键。

光标移动：前进/后退(返回)

返回=光标返回=移动到	返回到	前⼀次光标	⿏标	的位置

前进=光标前进=移动到	前进到	后⼀次光标	⿏标	的位置

的快捷键是：

Mac
	Back	=返回：	Command	+	[	

	Forward	=前进：	Command	+	]	

跳转到⻚⾸=⽂件开始处=⻚⾯顶部

PyCharm	⽂件最开始	⻚⾯开始	⻚⾯顶部

即	跳转	⻚⾸	⻚⾯开始

的快捷键：

Win
	Control	＋	Home	/	End	：跳转到⽂件的开始/末尾

Mac
	Command	＋	Fn	＋⬅�左键／右键➡�：跳转到⽂件的开始/末尾

说明

Mac中此处	Command	对应着Win中的	Control	

Mac中没有（直接的）Home/End键，⽽以实际上是：

	Fn	+⬅�左键＝	Home	

	Fn	＋右键➡�＝	End	
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CPython加速

详⻅：

【记录】PyCharm中安装Cython去加速调试
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问题和⼼得

已知问题

PyCharm也有⼀些⼩问题。整理如下：

log⽂件的语法⾼亮

记得，之前默认就已⽀持log⽇志⽂件的语法⾼亮显示的。

但是后来不知道何时何故log⽂件失去语法⾼了

去折腾过

【未解决】PyCharm中添加log⽂件⽀持语法⾼亮显示

但是并没有解决。

抽空再去找原因。

偶尔会⼀直indexing重建索引

PyCharm偶尔会有个bug：

⼀直处于indexing，且CPU占⽤率很⾼

解决办法：

	File	->	Invalidate	Caches/Restart	->重启PyCharm

⼀般均可解决。如果还不⾏，再多试试⼏次。

详⻅：【已解决】PyCharm⼀直在重新indexing建⽴索引

不⽀持在Markdown中粘贴图⽚

PyCharm中在Markdown中，不⽀持粘贴图⽚：

【未解决】PyCharm中markdown编辑器⽀持粘贴图⽚

其实这个问题，严格意思上不算是PyCharm的问题，⽽是属于Markdown的插件的问题。

但是与之对⽐，VSCode中⽀持Markdown中粘贴图⽚，很是好⽤：

Paste	Image	·	史上最好⽤的编辑器：VSCode

【已解决】VSCode中插件Paste	Image的粘贴图⽚快捷键Command+Alt+V失效	–	在路上

PyCharm⼼得

此处整理⼀些使⽤PyCharm的经验和⼼得。

更改⽂件类型使其语法⾼亮

macOS中	conf	⽂件之前被识别为	Text	，没有语法⾼亮：

问题和⼼得
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想要改为	ini	格式，以便于⽂件内容可以被语法⾼亮。

具体步骤：

	PyCharm	->	Preferences	->	Editor	->	File	Types	for	macOS	

然后删除	Text	中的	*.conf	

再给	ini	格式加上	*.conf	
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即可使得此处的	conf	⽂件，语法⾼亮显示了：
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参考资料

［已解决］Mac中的PyCharm如何移动到⽂件最开始和最末尾	–	在路上

【已解决】Mac中PyCharm中选⽤Python3结果：ModuleNotFoundError:	No	module	named	selenium
【已解决】Mac中PyCharm中找不到已安装的Scrapy库:	No	module	named	scrapy
【已解决】Python的正则re的search查找不到值

【未解决】PyCharm中添加log⽂件⽀持语法⾼亮显示

【⼼得】PyCharm正确设置Python解析器当前项⽬才能检测识别导⼊的库

【已解决】PyCharm中如何调试pipenv的虚拟环境中的python3的⽂件

【已解决】PyCharm中调试pipenv虚拟环境中⽂件出错：FileNotFoundError	Errno	2	No	such	file	or	directory
pipenv	run	python	py
【已解决】PyCharm中创建logger的RotatingFileHandler出错：FileNotFoundError	Errno	2	No	such	file	or
directory
【已解决】Mac中PyCharm中去加断点实时调试scrapy的项⽬

PyCharm	如何设置SciView⼯具窗⼝	-	CSDN博客

pycharm中显示额外的“figure”窗⼝	-	CSDN博客

新版pycharm中，取消matplotlib默认输出到sciview	-	CSDN博客

PyCharm：2017.3版即将新增科学计算模式，预览版现在可以下载使⽤	-	lemonbit	-	博客园

In	pycharm,	the	chart	displayed	by	matplotlib.pyplot.show	()	is	exported	to	sciview	and	how	to	play	it?	-	Code	Blog
Bt
Scientific	Mode	Tutorial	-	Help	|	PyCharm
Scientific	Mode	-	Help	|	PyCharm
SciView	-	Help	|	PyCharm
Python环境搭建及IDE选择	-	简书

Download	PyCharm:	Python	IDE	for	Professional	Developers	by	JetBrains
Professional	vs.	Community	-	Compare	Editions	|	PyCharm
PyCharm	Community	Edition	and	Professional	Edition	Explained:	Licenses	and	More	|	PyCharm	Blog
Differences	between	Pycharm	community	and	professional	edition?：Python
Pycharm的教育版和社区版有什么区别？	-	知乎

使⽤PyCharm进⾏Python远程调试

Pycharm的远程代码编辑	-	kiwik's	blog
【已解决】PyCharm⼀直在重新indexing建⽴索引

【已解决】PyCharm中重新设置⽂件解析语法格式

File	Types	–	Help	|	PyCharm
Register	New	File	Type	Association	Dialog	–	Help	|	PyCharm
【记录】PyCharm中安装Cython去加速调试

【已解决】⽤PyCharm同步代码到服务器以实现代码部署

【未解决】PyCharm中markdown编辑器⽀持粘贴图⽚

【已解决】PyCharm中Python代码提示：Shadows	name	from	outer	scope
【已解决】⽤PyCharm写Python的MongoDB代码并调试

【已解决】PyCharm中安装MongoDB的插件：mongo4idea
【已解决】⽤PyCharm的MongoDB插件连接远程MongoDB数据库

【已解决】PyCharm连接远程添加security的authorization的MongoDB出错：

com.mongodb.MongoCommandExceptions:	Command	failed	with	error	13
【已解决】Mac中PyCharm中Python代码调试报错：SyntaxError	Non-ASCII	character	\xe7	in	file	on	line	but	no
encoding
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